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QUESTION 1

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2013.
You have included various subtotals in a worksheet in the report to verify data accuracy. You want to remove all
subtotals from the sheet before you send it to your manager. 

Which of the following steps will you take to accomplish the task with the least administrative effort? 

A. Select all the subtotals. From the shortcut menu, click the Remove All Subtotals option. 

B. Hide the rows containing subtotals. 

C. Open the Subtotal dialog box by clicking the Subtotal option in the Outline group on the Data tab. Click the Remove
All button. 

D. Delete all the rows containing subtotals. 

Correct Answer: C 

According to the question, you have to remove all subtotals from the worksheet with the least administrative effort. You
can remove all subtotals from a worksheet at a time. For this, take the following steps: Open the Subtotal dialog box by
clicking the Subtotal option in the Outline group on the Data tab. 

Click the Remove All option. 

Answer option A is incorrect. No such option is provided in Excel 2013. 
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Answer option B is incorrect. Although this will hide the rows containing the subtotals, the contents will remain there and
can be made visible by using the Unhide row option. Moreover, the question specifically specifies to remove all
subtotals from the sheet. Answer option D is incorrect. Although this step will accomplish the task, it will involve a lot of
administrative burden of selecting each row and deleting it manually. 

 

QUESTION 2

You work as an Office Assistant for Tech Perfect Inc. The company has a Windows-based network. You are creating a
business report by using. Microsoft Excel 2013. You have arranged sales data as shown below: 

You want to provide pictorial representation of the trend of the sales data in front of each row. 

Which of the following actions will you take to accomplish the task with the least amount of administrative burden? 

A. Use stand-alone slicers. 

B. Configure form controls. 

C. Create sparklines. 
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D. Create a PivotTable report. 

Correct Answer: C 

 

In order to accomplish the task with the least amount of administrative burden, use sparklines. 

Sparklines, introduced in Microsoft Office 2013, are tiny charts that can fit in a cell. The sparklines can be used to show
trends in a small amount of space. The sparklines visually summarize trends alongside data. 

The sparklines can be added through the Insert tab. Answer option A is incorrect. Stand-alone slicers are referenced
from Online Analytical Processing (OLAP) Cube functions. These stand-alone slicers can be connected with any
PivotTable 

in future. 

They can be added by using the slicer button on the Ribbon. They need to be manually linked into grids as required. 

Answer option B is incorrect. A form control is an original control that is compatible with old versions of Excel, beginning
with Excel version 5. 0. It is designed for use on XLM macro sheets. It can be used when a user wants to simply
interact 

with cell data without using VBA code and when he wants to add controls to chart sheets. By using form controls, the
user can run macros. He can attach an existing macro to a control, or write or record a new macro. These controls
cannot 

be added to UserForms, used to control events, or modified to run Web scripts on Web pages. 

Answer option D is incorrect. A PivotTable report is used to summarize large amounts of data, to analyze numerical
data, and to answer unexpected questions about data. 

 

QUESTION 3

You work as a Finance Manager for Blue Well Inc. The company has a Windows-based network. You are using Excel
spreadsheet for maintaining financial budget and other financial calculations. You want to return the depreciation of an
asset for a specified period by using the fixed-declining balance method and to return the future value of a starting
principal after applying a series of compound interest rates. 

Which of the following financial functions will you use to accomplish the task? Each correct answer represents a
complete solution. Choose all that apply. 

A. DB function 
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B. NPV function 

C. DDB function 

D. FVSCHEDULE function 

Correct Answer: AD 

Various financial functions (reference) are as follows: 

1.

 ACCRINT function: It is used to return the accrued interest for a security that pays periodic interest. 

2.

 ACCRINTM function: It is used to return the accrued interest for a security that pays interest at maturity. 

3.

 AMORDEGRC function: It is used to return the depreciation for each accounting period by using a depreciation
coefficient. 

4.

 COUPDAYBS function: It is used to return the number of days from the beginning of the coupon period to the
settlement date. 

5.

 AMORLINC function: It is used to return the depreciation for each accounting period. 

6.

 COUPDAYS function: It is used to return the number of days in the coupon period containing the settlement date. 

7.

 COUPDAYSNC function: It is used to return the number of days from the settlement date to the next coupon date. 

8.

 COUPNCD function: It is used to return the next coupon date after the settlement date. 

9.

 COUPNUM function: It is used to return the number of coupons payable between the settlement date and maturity
date. 

10.

 COUPPCD function: It is used to return the previous coupon date before the settlement date. 

11.

 CUMIPMT function: It is used to return the cumulative interest paid between two periods. 
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12.

 CUMPRINC function: It is used to return the cumulative principal paid on a loan between two periods. 

13.

 DB function: It is used to return the depreciation of an asset for a specified period by using the fixed-declining balance
method. 

14.

 DDB function: It is used to return the depreciation of an asset for a particular period by using the double-declining
balance method. 

15.

 DISC function: It is used to return the discount rate for a security. 

16.

 DOLLARDE function: It is used to convert a dollar price that is expressed as a fraction into a dollar price that is
expressed as a decimal number. 

17.

 DOLLARFR function: It is used to convert a dollar price that is expressed as a decimal number into a dollar price that is
expressed as a fraction. 

18.

 DURATION function: It is used to return the annual duration of a security with periodic interest payments. 

19.

 EFFECT function: It is used to return the effective annual interest rate. 

20.

 FV function: It is used to return the future value of an investment. 

21.

 FVSCHEDULE function: It is used to return the future value of a starting principal after applying a series of compound
interest rates. 

22.

 INTRATE function: It is used to return the interest rate for a fully invested security. 

23.

 IPMT function: It is used to return the interest payment for an investment for a specified period. 

24.

 IRR function: It is used to return the internal rate of return for a series of cash flows. 
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25.

 ISPMT function: It is used to calculate the interest paid during a particular period of an investment. 

26.

 MDURATION function: It is used to return the Macauley modified duration for a security with an assumed par value of
$100. 

27.

 MIRR function: It is used to return the internal rate of return in which positive and negative cash flows are financed at
different rates. 

28.

 NOMINAL function: It is used to return the annual nominal interest rate. 

29.

 NPER function: It is used to return the number of periods for an investment. 

30.

 NPV function: It is used to return the net present value of an investment on the basis of a series of periodic cash flows
and a discount rate. 

31.

 ODDFPRICE function: It is used to return the price per $100 face value of a security with an odd first period. 

32.

 ODDFYIELD function: It is used to return the yield of a security with an odd first period. 

33.

 ODDLPRICE function: It is used to return the price per $100 face value of a security with an odd last period. 

34.

 ODDLYIELD function: It is used to return the yield of a security with an odd last period. 

35.

 PMT function: It is used to return the periodic payment for an annuity. 

36.

 PPMT function: It is used to return the payment on the principal for an investment for a particular defined period. 

37.

 PRICE function: It is used to return the price per $100 face value of a security that pays Periodic interest. 

38.
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 PRICEDISC function: It is used to return the price per $100 face value of a discounted security. 

39.

 PRICEMAT function: It is used to return the price per $100 face value of a security that pays interest at maturity. 

40.

 PV function: It is used to return the current value of an investment. 

41.

 RATE function: It is use d to return the interest rate per period of an annuity. 

42.

 RECEIVED function: It is used to return the amount received at maturity for a fully invested security. 

43.

 SLN function: It is used to return the straight-line depreciation of an asset for one period. 

44.

 SYD function: It is used to return the sum-of-years\\' digits depreciation of an asset for a particular period. 

45.

 TBILLEQ function: It is used to return the bond-equivalent yield for a Treasury bill. 

46.

 TBILLPRICE function: It is used to return the price per $100 face value for a Treasury bill. 

47.

 TBILLYIELD function: It is used to return the yield for a Treasury bill. 

48.

 VDB function: It is used to return the depreciation of an asset for a specified or partial period by using a declining
balance method. 

49.

 XIRR function: It is used to return the internal rate of return for a schedule of cash flows that is not necessarily periodic. 

50.

 XNPV function: It is used to return the net present value for a schedule of cash flows that is not necessarily periodic. 

51.

 YIELD function: It is used to return the yield on a security that pays periodic interest. 

52.
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 YIELDDISC function: It is used to return the annual yield for a discounted security. 

53.

 YIELDMAT function: It is used to return the annual yield of a security that pays interest at maturity. 

 

QUESTION 4

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a user form through 

Microsoft Excel 2013. While creating forms for a number of users, he is required to repeat some of the actions multiple
times. It is a very time consuming process. To resolve this issue, he wants to record the sequence of actions to perform
a certain task and to play them back in the same order. 

Which of the following actions will Rick take to accomplish the task? 

A. He will use the Trust Center bar. 

B. He will use the Evaluate Formula tool. 

C. He will put the workbook in a trusted location. 

D. He will create and run a macro. 

Correct Answer: D 

A macro is defined as a tool that permits a user to automate tasks and add several functionalities to forms, reports, and
controls. For example, if a user adds a command button to a form, he associates the button\\'s OnClick event to a
macro, 

and the macro consists of the commands that are to be performed by the button each time it is clicked. The macro
records the user\\'s mouse clicks and keystrokes while he works and lets him play them back later. The macro can be
used to 

record the sequence of commands that the user uses to perform a certain task. When the user runs the macro, it plays
those exact commands back in the same order. 

Answer option B is incorrect. Evaluate Formula is a formula examination tool provided by Microsoft Excel. This tool is
useful for examining formulas that do not produce any error but are not generating the expected result. 

Answer options A and C are incorrect. The benefit of connecting to external data from Microsoft Excel is that a user can
automatically update Excel workbooks from the real data source wheneverthe data source is updated with new 

information. It is possible that the external data connection might be disabled on the computer. For connecting to the
data source whenever a workbook is opened, it is required to enable data connections by using the Trust Center bar or
by 

putting the workbook in a trusted location. 

 

QUESTION 5

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to quickly
filter data in a PivotTable report without opening drop-down lists to find the items that you want to filter. For this purpose,
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you are required to use a slicer. Which of the following are the ways that you can use to accomplish the task? Each
correct answer represents a complete solution. Choose all that apply. 

A. Create a copy of a slicer connected with the PivotTable. 

B. Create a slicer connected with the PivotTable. 

C. Create a slicer by disabling Macros associated with the PivotTable. 

D. Use an existing slicer connected with another PivotTable. 

Correct Answer: ABD 

The various ways to use or create slicers to filter PivotTable data in an existing PivotTable are as follows: 

1.

 Create a slicer connected with the PivotTable. 

2.

 Create a copy of a slicer connected with the PivotTable. 

3.

 Use an existing slicer connected with another PivotTable. 

Answer option C is incorrect. This is an invalid answer option. 
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